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Before You Begin
This section introduces you to standard warranty provisions, safety precautions,
warnings and cautions, document formatting conventions, and sources of additional
product information. A documentation roadmap is also provided to guide you in finding
the appropriate information.

Warranty Information
To receive a copy of the standard warranty provision for this product, contact your local
Intermec support services organization. In the U.S.A. call 1-800-755-5505, and in
Canada call 1-800-668-7043. If you live outside the U.S.A or Canada, you can find your
local Intermec support services organization on the Intermec Web site at
www.intermec.com.

Safety Summary
Your safety is extremely important. Read and follow all warnings and cautions in this
book before handling and operating Intermec equipment. You can be seriously injured,
and equipment and data can be damaged if you do not follow the safety warnings and
cautions.

Do not repair or adjust alone    Do not repair or adjust energized equipment alone
under any circumstances. Someone capable of providing first aid must always be
present for your safety.

First aid    Always obtain first aid or medical attention immediately after an injury.
Never neglect an injury, no matter how slight it seems.

Resuscitation    Begin resuscitation immediately if someone is injured and stops
breathing. Any delay could result in death. To work on or near high voltage, you should
be familiar with approved industrial first aid methods.

Energized equipment    Never work on energized equipment unless authorized by a
responsible authority. Energized electrical equipment is dangerous. Electrical shock
from energized equipment can cause death. If you must perform authorized emergency
work on energized equipment, be sure that you comply strictly with approved safety
regulations.
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Warnings, Cautions, and Notes
The warnings, cautions, and notes in this manual use the following format.

Warning
A warning alerts you of an operating procedure, practice, condition, or statement
that must be strictly observed to avoid death or serious injury to the persons working
on the equipment.

Avertissement
Un avertissement vous avertit d’une procédure de fonctionnement, d’une méthode,
d’un état ou d’un rapport qui doit être strictement respecté pour éviter l’occurrence
de mort ou de blessures graves aux personnes manupulant l’équipement.

Caution
A caution alerts you to an operating procedure, practice, condition, or statement that
must be strictly observed to prevent equipment damage or destruction, or corruption
or loss of data.

Conseil
Une précaution vous avertit d’une procédure de fonctionnement, d’une méthode,
d’un état ou d’un rapport qui doit être strictement respecté pour empêcher
l’endommagement ou la destruction de l’équipement, ou l’altération ou la perte de
données.

Note: Notes are statements that either provide extra information about a topic or
contain special instructions for handling a particular condition or set of circumstances.
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About This Manual
This manual contains all of the information necessary to install, operate, configure,
troubleshoot, and maintain the Model 70 Pocket PC.

This manual was written for analysts and programmers who operate, program, and
connect the Pocket PC to a network or system. A basic understanding of DOS,
programming, and data communications is necessary.

Terms
You should be aware of how these terms are being used in this manual:

Term Description

Pocket PC The Intermec Model 70 Pocket PC.

PC cards “PC cards” are also known as “PCMCIA cards.”

Format Conventions for Input From a Keyboard or Keypad
This table describes the formatting conventions for input from PC or host computer
keyboards and reader keypads:

Convention Description

Special text Shows the command as you should enter it into the reader. See
“Format Conventions for Commands” later in this chapter.

Italic text Indicates that you must replace the parameter with a value. See
“Format Conventions for Commands” later in this chapter.

Bold text Indicates the keys you must press on a PC or host computer
keyboard. For example, “press Enter” means you press the key
labeled “Enter” on the PC or host computer keyboard.

Other Intermec Manuals
You may need additional information when working with the Pocket PC in a data
collection system. Please visit our Web site at www.intermec.com to download many of
our current manuals in PDF format. To order printed versions of the Intermec manuals,
contact your local Intermec representative or distributor.
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1
This chapter describes the features of the Intermec Model 70 Pocket PC. It also
explains how to maintain the batteries and use the AC adapters, cradles, and stylus.

Welcome
Congratulations on purchasing an Intermec Model 70 Pocket PC powered by Microsoft®

Windows® CE. This Pocket PC is the most convenient way to manage your business
and personal information. Microsoft ActiveSync increases the power of your Pocket PC
by allowing you to synchronize the information with your desktop or laptop computer.

To get your Pocket PC up and running

1. Activate the backup battery and charge the main battery pack.

2. Turn on the Pocket PC.

3. Follow the setup wizard.

4. Use ActiveSync to establish a partnership with your desktop or laptop computer.

For help, see the Model 70 Pocket PC Quick Start Guide (Part No. 962-054-034).

Pocket PC Description
Here are four views of the Pocket PC that describe its features.

Front Panel View

1

2

3

4

5

6

7
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Front Panel View

Item Component Function

�
Battery Charge and Alarm
Light

This light serves as both a battery charge
indicator and a visual alarm indicator.

• Flashing green: Notification alarm signal.

• Flashing amber: Battery is charging.

• Solid amber: Battery is fully charged.

�
Windows Key Displays the Start menu.

�
DC Jack Accommodates the DC connector of the AC

adapter.

� Power and Backlight Button Turns on and off your Pocket PC. Press and
release the button to turn on or off the Pocket
PC. Press and hold the button to turn on or off
the backlight.

These buttons open some of the most frequently
used applications.

Opens the Tasks application.

Opens the Contacts application.

Opens the Notes application.

� Program Buttons

Opens the Calendar application.

� Display Interprets stylus taps and displays information
onscreen.

�
Microphone The small hole at the top of the Pocket PC is the

microphone for the recorder.
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1
Back Panel View
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Item Component Function

� Reset Button This button is recessed inside the Pocket PC.
Occasionally, some hardware or software
malfunctions can prevent the Pocket PC from
responding. To get it working again, use the tip
of the stylus to press the Reset button.

� Backup Battery Compartment To open the backup battery cover, carefully press
your stylus under the semi-circular extension
resting in the indented shelf to the left of the
actual cover, then lift up the backup battery
cover with the stylus.

� Speaker Through the speaker you can hear alarms and
sound recordings.

� Communications Port This port establishes a hardware connection with
your desktop computer. You can connect the
Pocket PC to a desktop computer by using a
cradle or an auto-sync cable.

� Main Battery Compartment This compartment holds the rechargeable main
battery pack.  To open this cover, use your
thumbs to carefully slide the door horizontally
until it unlatches and then lift the door up and
away from the Pocket PC.
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Left Edge View

1 2 3
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Item Component Function

� System Manager Button Press to go to Your Desktop, which contains
your most essential programs.

� Action Button/Scroll Wheel This wheel has three actions.

• Press the center of the dial to use it as an
action button, like the Enter key on a full-
sized PC keyboard.

• Rotate the dial up to scroll upwards from
right to left through the desktop, or to scroll
up while you are using an application.

• Rotate the dial down to scroll downwards
from left to right through the desktop, or to
scroll down while you are using an
application.

� Record Button Hold down this button to record brief notes and
messages while speaking into the built-in
microphone. For more information, see Chapter
2, “Using the Pocket PC.”
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Top Edge View
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Item Component Function

� Infrared Port This port lets the Pocket PC exchange data with
other infrared-equipped devices. The infrared
port can transmit at speeds up to 115 Kbps For
more information, see Chapter 6, “Getting
Connected.”

� Stylus Compartment The stylus compartment stores the stylus. When
you are finished using the stylus, insert it back
into the compartment. For help on using the
stylus, see “Using the Stylus” later in this
chapter.

� Compact Flash Card Slot This slot is protected by a removable cover. It
supports Compact Flash Type I cards.

� Audio Jack This jack lets you connect an audio headset to
your Pocket PC.
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About the Batteries

Warning
Your computer contains a rechargeable lithium-ion battery pack. There is a risk of
fire and burns if the battery pack is handled improperly. Do not disassemble, crush,
puncture, short external contacts, or dispose of in fire or water. Do not attempt to
open or service the battery pack. Replace only with the battery pack designated for
this product. Discard used batteries according to the manufacturer's instructions.

Avertissement
Votre ordinateur est muni d'un bloc-batterie au lithium-ion. Le bloc-batterie présente
un risque d'incendie et de brûlures en cas de manipulation incorrecte. Ne pas
désassembler, écraser, trouer, court-circuiter les contacts externes, ou jeter dans un
feu ou dans de l'eau. Ne pas essayer d'ouvrir ou de réparer le bloc-batterie.
Remplacer uniquement par un bloc-batterie conçu pour ce produit. Jeter les batteries
usées conformément aux instructions du fabricant.

Warning
Your computer contains a coin-cell lithium battery. There is a danger of explosion
and risk of personal injury if the battery is incorrectly replaced or mistreated. Do not
attempt to recharge the battery, disassemble it, or immerse it in water or dispose of in
fire. Replace only with the battery designated for this product. Discard used batteries
according to the manufacturer's instructions.

Avertissement
Votre ordinateur est muni d'une batterie au lithium en forme de pièce. Le bloc-
batterie présente un danger d'explosion et un risque de blessures corporelles en cas
de manipulation ou de remplacement incorrect. Ne pas essayer de recharger le bloc-
batterie, de le désassembler, ou de l'immerger dans de l'eau ou de le jeter dans un feu.
Remplacer uniquement par un bloc-batterie conçu pour ce produit. Jeter les batteries
usées conformément aux instructions du fabricant.

Note: If you take out your main battery for any reason, do not turn on your Pocket PC
until you have replaced the battery cover and locked it securely back into place.
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1
Charging the Batteries
Your Pocket PC contains a rechargeable lithium-ion main battery pack and a coin-cell
lithium backup battery. The main battery pack charges each time you connect the
Pocket PC to an external power source with an AC adapter.

• If the battery is low on charge, the battery icon appears on the command bar on the
Today screen. Tap the battery icon to display the Power control panel.

• If the battery gets very low, your Pocket PC displays a warning message. If this
occurs, save any unsaved data, use ActiveSync to perform a synchronization with
your desktop computer, and turn off your Pocket PC. Charge the battery. For help
using ActiveSync, see the ActiveSync online help on your desktop computer.

• If your Pocket PC shuts down, the backup battery will maintain your data for about
40 hours. However, you should immediately charge the battery.

To charge the main battery pack

• Use an AC adapter to connect the Pocket PC directly to an external power source.

Or,

Place the Pocket PC in the cradle and use an AC adapter to connect the cradle to an
external power source.

Placing the Pocket PC in its Cradle

M70PPG002.eps

Note: Make sure you connect the Pocket PC to an external power source for a short
time each day to recharge the battery to its full capacity.
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Monitoring the Batteries
When you are working with your Pocket PC and using battery power, you can monitor
the charge held in the battery by using the Power window.

To conserve battery power, your Pocket PC automatically turns off whenever it is idle
for a continuous period of time. If you are running on battery power, you can conserve
the charge if you shorten the idle time before your Pocket PC automatically turns off.

To display the Power window

• Tap , Settings, System, and then Power.

The Power window only shows the battery charge level if you are using the battery. If
you have connected the AC adapter, the window shows the recharging status.

To set the power off timer

• Tap , Settings, System, and then Power.

• Use the drop down menus to set the idle intervals before your Pocket PC
automatically turns off.

• If you are playing an audio file on your Pocket PC under battery power, the
display will automatically turn off after one minute if there has been no input to
your Pocket PC. The display will turn back on once the audio file has finished
playing. This power saving feature is not adjustable.
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1
Managing the Batteries
This function is provided to help you maximize the battery life of your Pocket PC. By
enabling Power Saving mode, you reduce the speed of the Pocket PC’s CPU and save
on power consumption. This setting reduces the speed and performance of your Pocket
PC. If you need to use multimedia applications, choose Disable.

To enable Power Saving mode

1. Open Your Desktop either by pressing the Your Desktop button or by tapping the
Your Desktop button on the Programs screen.

2. Tap  and then choose Enable.

Your Desktop displays
your essential programs

Tap this icon to enable or
disable Power Saving
mode
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Power Saving Mode Screen

3. Tap Yes to restart the Pocket PC.

Note: Always save all the information on your Pocket PC before tapping Yes to reset. If
you have not saved all the information, tap No, then save all your important
information.
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Using the AC Adapters and Cradles

You must order an AC adapter for your Pocket PC that is compatible with your
country’s wall plug style. All adapters accept 110 or 220 VAC. The AC adapter
connects the DC jack of the Pocket PC directly to an external power source. You use the
same AC adapter to connect the cradle to an external power source.

Description Part No.

AC adapter, North America 871-013-050

AC adapter, Europe 871-013-052

AC adapter, United Kingdom 871-013-051

Your Pocket PC comes with an RS-232 cradle that lets you connect your Pocket PC to a
serial port on your desktop computer and charge the Pocket PC’s batteries at the same
time. You can also order a USB cradle (Part No. 871-013-010) that connects the Pocket
PC to a USB port on your desktop computer and charges the batteries.

You can order an RS-232 auto-sync cable (Part No. 871-013-030) or a USB auto-sync
cable (Part No. 871-013-040) that connects your Pocket PC directly to your desktop
computer, but does not let you charge the batteries.

To connect the cradle

1. Connect the cable that is attached to your RS-232 cradle to the serial port on your
desktop computer.

If you have a USB cradle, attach the cable to the USB port on your desktop
computer.
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Connecting the RS-232 Cradle to a Desktop Computer

M70PPG005.eps

2. Plug the AC adapter into the back of the cradle and connect it to a power outlet.

3. Dock the Pocket PC in the cradle.

While the battery is charging, the Battery Charge and Alarm light flashes amber. When
the light stops flashing and remains steady on, the battery is fully charged.

For more information on establishing a partnership between your Pocket PC and a
desktop computer, see the Model 70 Quick Start Guide and the ActiveSync online help
on your desktop computer.
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Using the Stylus

Your Pocket PC has a stylus for selecting items and entering information. You can use
the stylus to perform these actions:

Tap    Touch the screen once with the stylus to open items and select options.

Drag    Hold the stylus on the screen and drag across the screen to select text and
images. Drag within a list to select multiple items.

Tap-and-hold    Tap and hold the stylus on an item to see a list of actions available for
that item. Tap the action you want to perform on the pop-up menu that appears.

Reset    Use the stylus tip to press the reset button inside the Pocket PC.

To remove the stylus

1. Push the stylus up with your thumb.

2. Pull the stylus upwards out of its compartment.

To replace the stylus

1. Insert it back into the compartment.

2. Push it until it is in place.
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Where to Find Information
This user’s guide describes your Pocket PC, provides an overview of the programs on
your Pocket PC, and explains how to connect your Pocket PC to a desktop computer, a
network, or the Internet.

The following table is a guide to additional information to help you use your Pocket PC.

For information on: See this source:

Setting up your Pocket PC. The Intermec Model 70 Pocket PC Quick
Start Guide that shipped with your Pocket PC.

Programs on your Pocket PC. This user’s guide and the Pocket PC online

help. To view help, tap  and then Help.

Installing and using ActiveSync. The Intermec Model 70 Pocket PC Quick
Start Guide, the Microsoft Web site at
www.microsoft.com/mobile/pocketpc, and the
ActiveSync online help on your desktop
computer.

Last-minute updates and detailed technical
information on ActiveSync.

The Read Me files, located in the Microsoft
ActiveSync folder on the desktop computer.

Application development for the Pocket PC. The Microsoft Web site at
www.microsoft.com/windows/embedded/ce/
tools.

Up-to-date information on Pocket PC devices. The Microsoft Web site at
http://www.microsoft.com/mobile/pocketpc.
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2
This chapter explains how to use the Intermec Model 70 Pocket PC.

Turning the Pocket PC On and Off

• To turn your Pocket PC on and off, press the Power button.

M70PPG003.eps

Opening the Today Screen
When you turn on your Pocket PC for the first time each day, you should see the Today
screen. On this screen, you can see at a glance important information for the day.

To open the Today screen

• Use your stylus to tap  and then Today.

Tap here to adjust date
and time

Tap here to change the
contents of the Today
screen

Tap here to select and
open a program

Understand the status
icons. See the table on the
next page.

Tap New to open
a new program
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You may see the following status icons on the command bar.

Status Icon Meaning

Turns all sounds on and off

Backup battery is low

Backup battery is very low

Main batteries are charging

Main batteries are low

Main batteries are very low

External (AC) power source is connected

Dial-up connection is active

Direct connection is active

Opening Programs
You can switch from one program to another by selecting it from the Start menu. You
can customize which programs you see on this menu. For help, see “Customizing Your
Pocket PC,” later in this chapter.

Note: Some programs have abbreviated labels for check boxes and drop-down menus.
To see the full spelling of an abbreviated label, tap and hold the stylus on the label.
Drag the stylus off the label so that the command is not carried out.

To open a program

• Use your stylus to tap , Programs, and then the program name. The program
you selected opens.

Or,

• Press one of the four program buttons on the front panel. The icons on the buttons
identify which program opens.

Icon Program

Microsoft Task

Microsoft Contacts

Microsoft Notes

Microsoft Calendar
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The following table contains a partial list of programs that are on your Pocket PC.

Icon Program Description
Your Desktop Press this button on the left edge of the Pocket

PC to display Your Desktop. Your Desktop
displays your most essential programs.

Calculator Lets you solve numerical problems.

Calendar Keeps track of your appointments and create
meeting requests.

CF Backup Backs up the files on your Pocket PC to a
Compact Flash card.

Connections Lets you access all the connections set up on
your Pocket PC.

Contacts Keeps track of your friends and colleagues.

Expenses Enters and views transactions and checks on
your expenditure.

File Explorer Lets you find a file or program on your
Pocket PC.

Solitaire Game.

Inbox Sends and receives e-mail messages.

Infrared Receive Lets you exchange Contacts information with
another Pocket PC, synchronize with your
desktop computer, or get online via your
mobile phone or other infrared-equipped
devices.

Internet Explorer Views Web pages downloaded from your
desktop computer or connects to an ISP and
lets you browse the Web.

Microsoft Money Lets you manage your money.

Microsoft Reader Downloads and lets you read books.

Notes Creates handwritten or typed notes, drawings,
and recordings.

Pocket Excel Creates new workbooks or views and edits
Excel workbooks that were created on your
desktop computer.

Pocket Word Creates new documents or views and edits
Word documents that were created on your
desktop computer.

Tasks Keeps track of your tasks.
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Using the Navigation Bar and the Command Bar
The navigation bar is located at the top of the Pocket PC screen. It displays the active
program and current time, and it allows you to switch between programs and close
screens.

Use the command bar at the bottom of the screen to perform tasks in programs. The
command bar includes menu names, buttons, and the input panel button. To create a
new item in the current program, tap New. To see the name of a button, tap and hold the
stylus on the button. Drag the stylus off the button so that the command is not carried
out.

Tap to show Start menu

Tap to see additional
programs

Tap to customize your
Pocket PC
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2
Using Pop-up Menus

With pop-up menus, you can quickly choose an action for an item. For example, you
can use the pop-up menu in the contact list to quickly delete a contact, make a copy of a
contact, or send an e-mail message to a contact. The actions in the pop-up menus vary
from program to program.

To access a pop-up menu

1. Tap and hold the stylus on the item name that you want to perform the action on.

2. When the menu appears, lift the stylus and tap the action you want to perform.

Or,

Tap anywhere outside the menu to close the menu without performing an action.

Tap and hold to display
the pop-up menu

Lift the stylus and tap the
action you want

Tap in the space to close
the menu without
performing an action



Model 70 Pocket PC User’s Guide

2-8

Entering Information on the Pocket PC
You have several options for entering new information on your Pocket PC:

• Use the input panel to enter typed text by using the soft keyboard or Character
Recognizer.

• Write directly on the screen.

• Draw pictures on the screen.

• Record a message.

• Use ActiveSync to synchronize or copy information from your desktop computer to
your Pocket PC. For more information, see the ActiveSync online help on your
desktop computer.

Using the Input Panel
Use the input panel to enter information in any program on your Pocket PC. You can
type using the soft keyboard or you can write using Character Recognizer. In either
case, the characters appear as typed text on the screen.

To show or hide the input panel

1. Tap the Input Panel button.

2. Tap the arrow next to the Input Panel button to see your choices.

When you use the input panel, your Pocket PC anticipates the word you are typing or
writing and displays it above the input panel. When you tap the displayed word, it is
inserted into your text at the insertion point. The more you use your Pocket PC, the
more words it learns to anticipate.

Select an input method

Tap the up arrow to see
input method choices

Input panel symbol for
keyboard
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2
Typing With the Soft Keyboard

Note: You can set several different options for the input panel by tapping the up arrow
in the command bar and choosing Options.

To type with the soft keyboard

1. Tap the arrow next to the Input Panel button and then Keyboard.

2. On the soft keyboard that is displayed, tap the keys with your stylus.

To use Character Recognizer

1. Tap the arrow next to the Input Panel button and then Character Recognizer.

2. Write a letter in the box. There are two boxes so you can write another character or
letter while you wait for the first to be interpreted.

When you write a letter, it is converted to typed text that appears on the screen. For
specific instructions on using Character Recognizer, see Appendix A, “Specifications
and Other Helpful Information.”

Tap here if this word is the
right word
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To select typed text

• Drag the stylus across the text you want to select.

You can cut, copy, and paste text by tapping and holding the selected words and then
choosing an editing command on the pop-up menu, or by choosing the command on the
Edit menu.

Writing on the Screen
In any program that accepts writing, such as the Notes program and the Notes tab in
Calendar, Contacts, and Tasks, you can use your stylus to write directly on the screen.
Write the way you do on paper. When writing, you can edit and format what you have
written and convert the information to text at a later time.

To write on the screen

• Tap the Pen button to switch to writing mode. This action displays lines on the
screen to help you write.

Note: Some programs that accept writing may not have the Pen button. See the
documentation for that program to find out how to switch to writing mode.

Tap the pen button and
use your stylus to write
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To select writing

1. Tap and hold the stylus next to the text you want to select until the insertion point
appears.

2. Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools and then Undo and try again. You can
also select text by tapping the Pen button to deselect it and then dragging the stylus
across the screen.

You can cut, copy, and paste written text in the same way you work with typed text: tap
and hold the selected words and then choose an editing command on the pop-up menu,
or choose the command on the Edit menu.

Tips for getting good recognition

• Write neatly.

• Write on the lines and draw descenders below the line. Write the cross of the “t”
and apostrophes below the top line so that they are not confused with the word
above. Write periods and commas above the line.

• For better recognition, try increasing the zoom level to 300% using the Tools menu.

• Write the letters of a word closely and leave big gaps between words so that the
Pocket PC can easily tell where words begin and end.

• Hyphenated words, foreign words that use special characters such as accents, and
some punctuation cannot be converted.

• If you add writing to a word to change it (such as changing a “3” to an “8”) after
you attempt to recognize the word, the writing you add will not be included if you
attempt to recognize the writing again.
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Drawing on the Screen
You can draw on the screen in the same way that you write on the screen. The
difference between writing and drawing on the screen is how you select items and how
they can be edited. For example, selected drawings can be resized, while writing cannot.

To create a drawing

• Cross three ruled lines on your first stroke. A drawing box appears. Subsequent
strokes in or touching the drawing box become part of the drawing. Drawings that
do not cross three ruled lines will be treated as writing.

Note: You may want to change the zoom level so that you can more easily work on or
view your drawing. Tap Tools and then choose a zoom level.

To select a drawing

• Tap and hold the stylus on the drawing until the selection handle appears. To select
multiple drawings, deselect the Pen button and then drag to select the drawings.

You can cut, copy, and paste selected drawings by tapping and holding the selected
drawing and then choosing an editing command on the pop-up menu, or by choosing the
command on the Edit menu. To resize a drawing, make sure the Pen button is not
selected and drag a selection handle.

The drawing box defines
the boundaries of the
drawing

Tap the pen button and
use your stylus to draw
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Recording a Message
In any program where you can write or draw on the screen, you can also capture
thoughts, reminders, and phone numbers by recording a message. In the Notes program,
you can either create a stand-alone recording or include a recording in a written note. If
you want to include the recording in a note, open the note first.

To record a message

1. Hold the Pocket PC microphone near your mouth or other source of sound.

2. Press and hold the Record button on your Pocket PC until you hear a beep.

Or, tap the Record button on the Recording toolbar.

3. Create your recording.

4. To stop recording, release the Record button or tap the Stop button on the
Recording toolbar. Two beeps will sound. The new recording appears in the note
list or as an embedded icon.

To play a recording

• Tap it in the list or tap its icon in the note.

Tap to begin recording

Tap to show or hide the
Recording toolbar

Tap to stop recording
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Finding and Organizing Information
The Find feature on your Pocket PC helps you quickly locate information.

To find a folder or file

1. On the  menu, tap Find.

2. In the Find field, enter the text you want to find.

3. In the Type field, select a data type

4. Tap Go to start the search. The results will appear in the Results box.

Note: To quickly find files that are taking up storage space on your Pocket PC, select
Larger than 64 KB in Type.

You can also use the File Explorer to find files on your Pocket PC and to organize these

files into folders. On the  menu, tap Programs, and then File Explorer.

Note: You can move files in File Explorer by tapping and holding the item you want to
move and then tapping Cut or Copy and Paste on the pop-up menu.

Select the sort order for
the list

Tap the folder name to
open it

Tap and hold to create a
new folder
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Using Compact Flash Cards

The Compact Flash Card expansion slot supports Type I Compact Flash cards. The
Compact Flash slot lets you install storage cards for backup and storage of data and
applications. It also allows you to install communication devices such as a LAN adapter
or a fax/modem.

To insert a Compact Flash card

• Push the card, connector-side first, into the slot until it stops.

To remove a Compact Flash card

1. Close all applications on your Pocket PC that have open files on the Compact Flash
card.

2. Lever the Compact Flash card out of the slot using a fingernail.

Guidelines
Your Pocket PC automatically recognizes a wide range of Compact Flash cards
approved for use with Windows CE. If you are ever instructed to install card-specific
Pocket PC drivers provided by a Compact Flash card manufacturer, be sure to install
only device drivers specifically designed for the Windows CE operating system on your
Pocket PC. If you are unclear about installation instructions, call your Compact Flash
card manufacturer for more information.

• Some Compact Flash cards consume large amounts of power. To avoid excessive
battery drainage when using a Compact Flash card, connect your Pocket PC to AC
power wherever possible.

• If the battery is very low, you should not attempt to save data to a Compact Flash
card. This may result in the loss of data. First replace the batteries or connect to AC
power.

• Do not turn off your Pocket PC or remove the Compact Flash card when you are in
the middle of performing an operation, such as saving data to your Compact Flash
card.

• Keep your Compact Flash card in a protective casing when not in use to protect
from dirt, moisture and static electricity.
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Backing Up and Restoring Data
To avoid losing your data in the event that your Pocket PC is lost, stolen, or becomes
damaged, periodic backups to the computer or a Compact Flash card are recommended.
Depending on your usage, you may want to perform a backup as often as once a day.
You can back up and restore your Pocket PC’s data using the following utilities:

ActiveSync Backup/Restore    Use this ActiveSync utility to periodically back up your
Pocket PC’s data onto your desktop computer’s hard drive. You can manually back up
data or set this utility to back up automatically each time you connect to your Pocket
PC. For more information, see the ActiveSync online help on your desktop computer.

CF Backup    This utility lets you back up and restore your entire Pocket PC’s memory
contents to a Compact Flash storage card (purchased separately). You can then carry a
copy of your data with you at all times for quick retrieval.

Backing Up Data to a Compact Flash Card
Each time you use the CF Backup utility, your data files, databases, preferences,
Windows CE system data, and applications are copied to the Compact Flash card. You
should use a card at least as big as your Pocket PC’s RAM (Random Access Memory)
size, e.g., 16 or 32 MB.

To perform a backup

1. Connect the Pocket PC to external power or tap Settings, System, then Power to
verify that the battery has a charge rating of 20% or greater.

Or,

Install a Compact Flash card into your Pocket PC. For help, see “Using Compact
Flash Cards” earlier in this chapter.

2. Tap , Programs, then CF Backup. The screen displays a list of all the items that
will be backed up, so it is easy to identify the data and size that is saved to the
Compact Flash storage card.



Using the Pocket PC

2-17

2
CF Backup Screen

3. Tap Start to begin the backup process. A status bar reports the data activity until
the function is complete.

Note: Do not remove the Compact Flash card or turn off the Pocket PC during
backup. You may lose data.

4. When the backup is complete, remove the Compact Flash storage card and keep it
close for easy retrieval.

Lists the items to be
backed up

Displays the amount of
data to be backed up

Displays the status of the
backup or restore.

Tap Start to start
the backup or
restore

Tap Backup to do a
backup

Tap Restore to do a
restore
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Restoring Data From a Compact Flash Card

1. Install the Compact Flash card that contains the backed up data into your Pocket
PC.

2. Close all active programs.

3. Tap , Programs, then CF Backup.

4. Tap Restore.

5. Tap Start to begin the restore process. A status bar reports the data activity until the
function is complete.

Note: Do not remove the Compact Flash card, or turn off the unit during restore.
You may lose data.

6. The reset screen will appear when the restore process is complete.
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2
Customizing Your Pocket PC

You can customize your Pocket PC by adjusting settings and by installing programs.
You can adjust Pocket PC settings to suit the way you work. To see available options,
tap, Settings, then the Personal or System tab located at the bottom of the screen. You
can do the following:

Item Tab Description

About System Find out about your Pocket PC. You may need this information if you
add programs or if you call Intermec Technical Support.

Align Screen System Adjust the touch screen if it is not responding accurately.

Backlight System Set the length of time before the backlight turns off when the Pocket
PC is idle. For help, see “Adjusting the Backlight” later in this chapter.

Buttons Personal Change the association of the program buttons so that they open
different programs. Adjust the up/down control of the jog wheel.

Clock System Change the time or set alarms.

Contrast System Adjust the contrast of the screen.

Game Keys System Define the program buttons as left/right and up/down game keys.
Define the Start button to fire.

Input Personal Customize the input method and set word completion settings.

Memory System Adjust the allocation of storage and program memory.

Menus Personal Customize what appears on the  menu or enable a pop-up menu
from the New button. For help, see “Customizing the Start Menu” later
in this chapter.

Owner Information Personal Enter your personal information.

Password Personal Limit access to your Pocket PC. For help, see “Setting a Password”
later in this chapter.

Power System Maximize battery life. For help, see “Monitoring the Batteries” in
Chapter 1.

Regional Settings System Adjust for region, numbers, currency, time and date.

Remove Programs System Remove program in storage memory. For help, see “Adding or
Removing Programs” later in this chapter.

Sounds and
Reminders

Personal Adjust the volume, choose when and what sounds to enable, and
choose other reminders. For help, see “Setting Notifications” later in
this chapter.

Today Personal Customize the information displayed on the Today screen.
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Setting a Password
Password security is provided to help protect against unauthorized use of your Pocket
PC. For immediate protection, we recommend setting up password security through the
Password utility in the Settings of your Pocket PC as soon as possible. If set, your
login password must be entered each time you turn on your Pocket PC.

Choose a password that is easy to remember. If you forget your password, you must
perform a full reset to use your Pocket PC. A full reset restarts your Pocket PC and
removes all information that was stored in memory, such as your data files and your
system settings.

To set your login password

1. Tap , Settings, then Password.

2. Enter a new 4-digit PIN. This number is now your password.

3. Enable the login password by checking the Require password when device is turned
on check box.

4. Save your new settings by tapping OK.

Your login password is now set. The login password screen appears each time you turn
on your Pocket PC.

Adding or Removing Programs
Programs added to your Pocket PC at the factory are stored in ROM (read-only
memory). You cannot remove or modify this software, and you will never accidentally
lose ROM contents. Programs and data files added to your Pocket PC after factory
installation are stored in RAM (random access memory). You can install any program
created for Pocket PC, as long as your Pocket PC has enough memory. The most
popular place to find software for your Pocket PC is on the World Wide Web.

You need to install the appropriate software for your Pocket PC on your desktop
computer before you can install it on your Pocket PC.
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To add programs

1. Determine your Pocket PC and processor type so that you know which version of

the software to install. Tap  and then Settings. On the System tab, tap About. In
the Version tab, make a note of the information in Processor.

2. Download the program to your desktop computer (or insert the CD or disk that
contains the program into your desktop computer). You may see a single *.exe file,
a *.ZIP file, a SETUP.EXE file, or several versions of files for different device
types and processors. Be sure to select the program designed for Pocket PC and
your processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with
the program. Many programs provide special installation instructions.

4. Connect your Pocket PC and desktop computer.

5. Double-click the *.EXE file.

• If the file is an installer, the installation wizard will begin. Follow the directions
on the screen. Once the software has been installed on your desktop computer,
the installer will automatically transfer the software to your Pocket PC.

• If the file is not an installer, you will see an error message stating that the
program is valid but it is designed for a different type of computer. You will
need to move this file to your Pocket PC. If you cannot find any installation
instructions for the program in the Read Me file or documentation, use
ActiveSync Explore to copy the program file to the Program Files folder on
your Pocket PC. For more information on copying files using ActiveSync, see
the ActiveSync online help.

Once installation is complete, tap , Programs, and then the program icon to switch
to it.

To remove programs

1. Tap  and then Settings.

2. In the System tab, tap Remove Programs.

If the program does not appear in the list of installed programs, use File Explorer on
your Pocket PC to locate the program, tap and hold the program, and then tap Delete on
the pop-up menu.
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Customizing the Start Menu

• Tap , Settings, Menus, the Start Menu tab, and then the check box for the
program. If you do not see the program listed, you can either use File Explorer on
your Pocket PC to move the program to the Start Menu folder or use ActiveSync on
the desktop computer to create a shortcut to the program and place the shortcut in
the Start Menu folder.

• Use File Explorer. Tap , Programs, File Explorer, and locate the program
(tap the folder list, labeled My Documents (default), and then My Device to
see a list of all folders on the Pocket PC). Tap and hold the program and then
tap Cut on the pop-up menu. Open the Start Menu folder located in the
Windows folder, tap and hold a blank area of the window, and then tap Paste

on the pop-up menu. The program will now appear on the  menu. For more
information on using File Explorer, see “Finding and Organizing Information”
earlier in this chapter.

• Use ActiveSync on the desktop computer. Use the ActiveSync Explorer to
explore your Pocket PC files and locate the program. Right-click the program,
and then click Create Shortcut. Move the shortcut to the Start Menu folder in

the Windows folder. The shortcut now appears on the  menu. For more
information, see the ActiveSync online help.

Setting Notifications
Your Pocket PC can remind you visually and audibly when you have something to do,
such as an appointment in Calendar or a task with a due date in Tasks. For example, if
you have an alarm in Clock, you can set the Pocket PC to notify you in any of the
following ways:

• A sound, which you can specify the volume and type, is played.

• A message box appears on the screen.

• A light flashes on your Pocket PC.

To set a notification

1. Use your stylus to tap  and then Settings.

2. In the Personal tab, tap Sounds & Reminders.
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2
Setting Volume

3. Use the tabs to choose the volume, sound types and reminder types.

The options you choose here apply throughout the Pocket PC.
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Adjusting the Backlight
Pocket PC features a built-in backlight that allows you to view text and graphics clearly
whether you are indoors or outdoors, in a dim study or at a brightly lit work site.

To turn on or off the backlight

• To turn the backlight on or off, press and hold the Power button for about three
seconds.

To adjust the backlight timeout

1. Use your stylus to tap  and then Settings.

2. In the System tab, tap Backlight.

3. Use the drop-down menus to set the amount of idle time before the backlight turns
off when your Pocket PC is using battery power and external power.
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Tap Edit to edit the
programs on Your Desktop

Using Your Desktop
The Your Desktop utility greatly speeds up access to and management of programs on
your Pocket PC. You can immediately view and open your essential programs by
placing them on a special desktop screen, which can be activated anytime by pressing
the Your Desktop button or by tapping the Your Desktop button. And, you can use the
System Manager to quickly close individual or all open programs.

Note: The programs shown above on Your Desktop the default icons on every Pocket
PC. If the Pocket PC is reset, it will return to these default icons.

Your Desktop displays
your essential programs

Tap this icon to open
System Manager
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Adding Program Icons to Your Desktop

1. Open Your Desktop either by pressing the Your Desktop button on the left-hand
side of your Pocket PC or by tapping Your Desktop on the Programs screen.

2. Tap Edit and then New.

3. Select the folder containing the file you want to add to Your Desktop, select the
appropriate file, and then tap OK.

If you cannot find the file you want or you are not sure what folder it is in, you can
navigate through the folders by tapping them. Tap Back to return to the previous
screen. (The maximum number of icons allowed on Your Desktop is 21.)

Click to go back to the
previous folder or file

The folder appears here
after you tap it

Tap a file from the list

Tap here to add the
program icon to Your
Desktop
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Deleting Program Icons From Your Desktop

1. Use the jog wheel or stylus to select the program icon.

2. Tap Edit and then Delete.

3. Tap Yes to confirm the deletion.

Tap to delete the selected
program icon
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Managing Programs in Your Desktop
You can use the System Manager to manage programs that are running on your Pocket
PC. You have three choices:

• You can stop all programs that are running.

• You can stop one program that is running.

• You can go to a program that is running.

To manage programs

1. Tap the System Manager  icon.

2. Choose a program in the Running Program List and tap Activate, Stop, or Stop All.

Select a program from the
list to start or stop

Tap Stop All to stop all
programs

Tap Stop to stop a
program

Tap Activate to open a
program
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Tap New to create a new
appointment

This chapter explains how to use Microsoft Pocket Outlook  on your Intermec  Model
70 Pocket PC. Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes.
You can use these programs individually or together.

Using Calendar
Use Calendar to schedule appointments and meetings and to create meeting requests.
You can check your appointments in one of several views (Agenda, Day, Week, and
Month) and easily switch views by using the View menu.

Keep your Calendar current by synchronizing your Pocket PC with Microsoft Outlook
or Microsoft Schedule+ on your desktop computer. For help, see the ActiveSync online
help on your desktop computer.

To open the Calendar program

• Tap , and then tap Calendar.

Note: You can customize the Calendar screen, such as changing the first day of the
week, by tapping Options on the Tools menu.

Tap to move to today

Tap to display or edit an
appointment
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Entering Appointments

1. If you are in Day or Week view, tap the desired date and time for the appointment.

2. Tap New.

3. Using the input panel, enter a description and a location. Tap first to select the field.

4. If needed, tap the date and time to change them.

5. Enter other desired information. You will need to hide the input panel to see all
available fields.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For
more information on creating notes, see “Using Notes,” later in this chapter.

7. When finished, tap ok to return to the calendar.

Note: If you select Remind me in an appointment, your Pocket PC will remind you
according to the options set in , Settings, Personal tab, Sounds & Reminders.

Tap ok to return to the
calendar

Tap in this field to choose
from predefined text

Tap to select a time and
date

Notes is a good place for
maps and directions
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About the Calendar Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed. Tap the top
portion of the summary screen to change the appointment.

Creating Meeting Requests
You can use Calendar to set up meetings with users of Pocket Outlook, Outlook, or
Schedule+. The meeting notice will be created automatically and sent either when you
synchronize Inbox or when you connect to your e-mail server. Indicate how you want
meeting requests sent by tapping Tools and then Options. If you send and receive e-
mail messages through ActiveSync, select ActiveSync.

To create a meeting request

1. Create an appointment.

2. In the appointment details, hide the input panel, and then tap Attendees.

3. From the list of e-mail addresses you have entered in Contacts, select the meeting
attendees.

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see the Calendar
online help and the Inbox online help on the Pocket PC.

Tap to edit appointment
details

Tap to enter notes
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Using Contacts
Contacts maintains a list of your friends and colleagues so that you can easily find the
information you are looking for, whether you are at home or on the road. Using the
infrared (IR) port, you can quickly share Contacts information with other Windows-
powered device users.

Keep your Contacts current by synchronizing your Pocket PC with Microsoft Outlook
or Microsoft Exchange on your desktop computer. For help, see the ActiveSync online
help on your desktop computer.

To open the Contacts program

• Tap , and then tap Contacts.

Note: To change the way information is displayed in the list, tap Tools and then
Options.

Tap and enter part of a
name to quickly find it in
the list

Tap a block to see
additional phone numbers
and e-mail addresses

Tap to display or edit the
contact details

Tap and hold to display a
pop-up menus of actions
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Creating Contacts

1. Tap New.

2. Using the input panel, enter a name and other contact information. You need to
scroll to see all available fields.

3. To assign the contact to a category, scroll to and tap Categories and select a
category from the list. In the contact list, you can display contacts by category.

4. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For
more information on creating notes, see “Using Notes” later in this chapter.

5. When finished, tap ok to return to the contact list.

Tap ok to return to the
contact list (the list is
saved automatically)

Scroll to see more fields

Notes is a good place for
maps and directions
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About the Contacts Summary Screen
When you tap a contact in the contact list, a summary screen is displayed.

Tap to edit the contact
details

Tap to enter or edit notes
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Using Tasks

Use Tasks to keep track of what you have to do. In the task list, overdue tasks are
displayed in bold.

Keep your Tasks current by synchronizing your Pocket PC with Microsoft Outlook on
your desktop computer. For help, see the ActiveSync online help on your desktop
computer.

To open the Tasks program

• Tap , and then tap Tasks.

Note: To change the way information is displayed in the list, tap Tools and then
Options.

Tap a heading to select
the sort order of the list

Tap to display or edit the
task details

Tap and hold to display a
pop-up menu of actions

Indicates high
priority
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Creating Tasks

1. Tap New.

2. Using the input panel, enter a description.

3. You can enter a start date and due date or enter other information by first tapping
the field. If the input panel is open, you will need to hide it to see all available
fields.

4. To assign the task to a category, tap Categories and select a category from the list.
In the task list, you can display tasks by category.

5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For
more information on creating notes, see “Using Notes,” later in this chapter.

6. When finished, tap ok to return to the task list.

Note: To quickly create a task with only a subject, tap Entry Bar on the Tools menu.
Then, tap Tap here to add a new task and enter your task information.

Tap ok to return to the
contact list (the contact is
saved automatically)
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About the Tasks Summary Screen
When you tap a task in the task list, a summary screen is displayed.

Tap to edit the task details

Tap to show and hide
additional summary
information

Tap to enter or edit notes



Model 70 Pocket PC User’s Guide

3-12

Using Notes
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes.
You can create a written note or a recording. You can also include a recording in a note.
If a note is open when you create the recording, it will be included in the note as an
icon. If the note list is displayed, it will be created as a stand-alone recording.

Keep your Notes current by synchronizing your Pocket PC with Microsoft Outlook on
your desktop computer. For help, see the ActiveSync online help on your desktop
computer.

To create a note

1. Tap , and then tap Notes.

2. Tap New.

3. Create your note by writing, drawing, typing, and recording. For help, see “Entering
Information on the Pocket PC” in Chapter 2.

Tap the keyboard icon to
show or hide the input
panel

Tap ok to return to the
note list

Tap the pencil icon to
write on the screen

Tap the tape icon to add a
recording to the note
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Using Inbox

Use Inbox to send and receive e-mail messages in either of these ways:

• Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on
your desktop computer.

• Send and receive e-mail messages by connecting directly to an e-mail server
through an Internet service provider (ISP) or a network.

Synchronizing E-Mail Messages
E-mail messages can be synchronized as part of the general synchronization process.
First, you need to enable Inbox synchronization in ActiveSync options. For information
on enabling Inbox synchronization, see the ActiveSync online help on the desktop
computer.

During synchronization:

• E-mail messages are copied from the Inbox folder of Exchange or Outlook on your
desktop computer to the Inbox folder on your Pocket PC. The e-mail messages on
the two computers are linked, so when you delete an e-mail message on your Pocket
PC, it is also deleted from your desktop computer the next time you synchronize.

• E-mail messages in the Outbox folder on your Pocket PC are transferred to
Exchange or Outlook, and then sent from those programs.

Note: You can also synchronize e-mail messages with your desktop computer from a
remote location. For more information, see Chapter 6, “Getting Connected.”

Connecting Directly to an E-Mail Server
In addition to synchronizing e-mail messages with your desktop computer, you can send
and receive e-mail messages by connecting to an e-mail server using a modem or
network card connected to your Pocket PC. You need to set up a remote connection to a
network or an ISP, and a connection to your e-mail server. For more information, see
“Connecting Directly to an E-Mail Server” in Chapter 6.

When you connect to the e-mail server, new messages are downloaded to the Pocket PC
Inbox folder, messages in the Outbox folder are sent, and messages that have been
deleted on the e-mail server are removed from the Inbox.

Messages that you receive directly from an e-mail server are linked to your e-mail
server rather than your desktop computer. When you delete a message on your Pocket
PC, it is also deleted from the e-mail server the next time you connect.
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Tap to connect to the
selected service

You can work online or offline. When working online, you read and respond to
messages while connected to the e-mail server. Messages are sent as soon as you tap
Send, which saves space on your Pocket PC. When working offline, once you have
downloaded new message headers or partial messages, you can disconnect from the
e-mail server and then decide which messages to download completely. The next time
you connect, Inbox downloads the complete messages you have marked for retrieval
and sends the messages you have composed.

Understanding Received E-Mail Messages
Messages you receive are displayed in the message list. By default, the most recently
received messages are displayed first in the list.

To open the Inbox program

• Tap , and then tap Inbox.

Unread messages are displayed in bold. To read a message, tap it in the list to open it.

Tap a heading to select
the sort order for the
messages

Tap to open a message

Tap and hold to display a
pop-up menu of actions

Tap to connect and to
send and receive e-mail
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Tap this icon to delete a
message

Inbox Screen

When you connect to your e-mail server or synchronize with your desktop computer,
Inbox downloads only the first 100 lines of each new message (default). The original
messages remain on the e-mail server or your desktop computer. No e-mail attachments
are downloaded. You need to download a full message before you can view its
attachments.

You can mark the messages that you want to retrieve in their entirety the next time you
synchronize or connect to your e-mail server. In the message list, tap and hold the
message you want to retrieve. On the pop-up menu, tap Get Full Copy. The icons in the
Inbox message list give you visual indications of message status.

Attachments appear as icons in a window at the bottom of the message. Tapping an
attachment icon opens the attachment if it has been fully downloaded or marks it for
download the next time you synchronize or connect to your e-mail server.

Tap ok to return to the
message list

Tap to show or hide the
complete header

Tap the up arrow or down
arrow to view the previous
or next message

Tap this icon to reply to or
forward this message
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You specify your downloading preferences when you set up the service or select your
synchronization options. You can change them at any time:

• Change options for Inbox synchronization using ActiveSync options. For more
information, see the ActiveSync online help on the desktop computer.

• Change options for direct e-mail server connections in Inbox on your Pocket PC.
Tap Tools and then tap Options. On the Service tab, tap the service you want to
change.

Composing and Sending E-Mail Messages

1. Tap New.

2. Enter an e-mail address in To, or select a name from the contact list by tapping the
Address Book button. All e-mail addresses entered in the e-mail fields in Contacts
appear in the Address Book.

3. Compose your message.

4. Tap Send when you have finished the message.

Tap the Send
button to send
the message

Tap to show or hide the
complete header

Tap this icon to attach a
file

Tap this icon to display the
Address Book

Enter your message here
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The message is placed in the Outbox folder on your Pocket PC and will be delivered in
one of two ways:

• They are transferred to the Outbox folder in Exchange or Outlook on your desktop
computer and then sent the next time you synchronize.

• They are transferred to your e-mail server the next time you connect. In Inbox,
make sure the appropriate service is selected on the Services menu. Then tap the
Connect button (or Connect on the Services menu).

Managing E-Mail Messages and Folders
By default, messages are displayed in one of four folders for each service you have
created: Inbox, Deleted (local), Outbox, and Sent. You can move or copy messages
between folders and you can create new folders.

To move or copy a message to another folder

1. Tap and hold the message and then tap Move to or Copy to on the pop-up menu.

2. Follow the instructions on the screen.

To create a new folder

1. Tap Tools, and then New Folder.

2. Enter a name for the new folder.

The Deleted folder contains messages that have been deleted on the Pocket PC. If you
are using IMAP4, you may see a Deleted Items folder. This folder is for messages
deleted on the e-mail server. The behavior of the Deleted and Sent folders depends on
the options you have chosen. In the message list, tap Tools and then Options. On the
Message tab, select your options.

Folder Behavior With ActiveSync
If you move e-mail messages into a folder you create, the link is broken between these
e-mail messages and their copies on the desktop computer. When you synchronize next,
the e-mail messages in the folder you created will not be synchronized. Also, e-mail
messages that are missing from the Pocket PC Inbox folder will be deleted from the
Inbox folder on the desktop computer so that both Inbox folders match. This prevents
you from getting duplicate copies of an e-mail message, but it also means that you will
no longer have access to the e-mail messages you move out of Inbox except from the
Pocket PC.
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Folder Behavior With A Direct Connection To An E-Mail Server
The behavior of the folders you create depends on whether you are using POP3 or
IMAP4:

• If you are using POP3, folders will behave like they do when using ActiveSync.

• If you are using IMAP4, the folders you create and the messages you move are
mirrored on the e-mail server.

For example, if you move two messages from the Pocket PC Inbox folder to a
folder called Family, the e-mail server will create a copy of the Family folder on
your desktop computer and move the messages into that folder. Therefore, messages
are available to you anytime you connect to your e-mail server, whether it is from
your Pocket PC or desktop computer. This synchronization of folders occurs when
you create a new folder, move e-mail messages into a folder, or tap Synchronize
Folders on the Services menu. If you want to view the messages in a folder while
disconnected from your e-mail server, select the folder and then tap Folder
Available Offline on the Services menu. This downloads the e-mail message in the
folder to your Pocket PC.
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This chapter explains how to use Microsoft Pocket Internet Explorer on your Intermec
Model 70 Pocket PC.

Setting Up Pocket Internet Explorer
Use Pocket Internet Explorer to view Web pages in either of these ways:

• During synchronization, download your favorite links, mobile favorites, and mobile
channels that are stored in the Mobile Favorites subfolder in Internet Explorer on
the desktop computer to your Pocket PC.

• Connect to an Internet service provider (ISP) or network and browse the Web. To
do this, you need to create the connection, as described in Chapter 6, “Getting
Connected.”

To open Pocket Internet Explorer

• Tap  and then Internet Explorer.

About the Mobile Favorites Folder
Only links stored in the Mobile Favorites subfolder in the Favorites folder in Internet
Explorer on your desktop computer will be synchronized with your Pocket PC. This
folder was created automatically when you installed ActiveSync. For more information
on synchronization, see the ActiveSync online help on the desktop computer.

During synchronization, the Mobile Favorites folder on your desktop computer is
synchronized with Pocket Internet Explorer on your Pocket PC. Both computers are
updated with changes made to either list each time you synchronize. Note that only the
link is downloaded to your Pocket PC. Unless you mark the link as available offline,
you will need to connect to your ISP or network to view the content.

Creating Mobile Favorites
If you are using Microsoft Internet Explorer 5 on your desktop computer, you can
download mobile favorites. Synchronizing mobile favorites downloads Web content to
your Pocket PC so that you can view Web pages while you are disconnected from your
ISP and desktop computer.
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Mobile favorites take up storage memory on your Pocket PC. To minimize the amount
of memory used:

• In the settings for the Favorites information type in ActiveSync options, turn off
pictures and sounds or stop some mobile favorites from being downloaded to the
Pocket PC. For more information, see the ActiveSync online help on the desktop
computer.

• Limit the number of downloaded linked pages. In Internet Explorer on the desktop
computer, right-click the mobile favorite you want to change and then Properties.
On the Download tab, specify 0 or 1 for the number of linked pages you want to
download.

Use the Internet Explorer 5 plug-in installed with ActiveSync to create mobile favorites
quickly.

To create a mobile favorite

1. In Internet Explorer 5 on your desktop computer, click Tools and then Create
Mobile Favorite.

2. To change the link name, enter a new name in the Name box.

3. Optionally, in Update, select a desired update schedule.

4. Click OK. Internet Explorer downloads the latest version of the Web page to your
desktop computer.

5. To download the pages that are linked to a mobile favorite, in Internet Explorer on
the desktop computer, right-click the mobile favorite and then click Properties. On
the Web Document tab, check the Make available offline check box.

6. To set the number of pages to download, right-click the mobile favorite and then
click Properties. On the Download tab, specify the number of links deep you want
to download. To conserve memory, only go 1 level deep.

7. Synchronize your Pocket PC and desktop computer. Mobile favorites that are stored
in the Mobile Favorites folder in Internet Explorer 5 are downloaded to your Pocket
PC.

Note: If you did not specify an update schedule in step 3, you will need to manually
download content to keep the information updated on your desktop computer and
Pocket PC. Before synchronizing with your Pocket PC, in Internet Explorer on your
desktop computer, click Tools and then Synchronize. You will see the last time content
was downloaded to the desktop computer, and you can manually download content if
needed.

You can add a button to the Internet Explorer toolbar for creating mobile favorites. In
Internet Explorer 5 on your desktop computer, click View, Toolbars, and then
Customize.
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About Channels
Channels are Web sites designed specifically for offline viewing on your Pocket PC.
You can subscribe to two types of channels for free: AvantGo Channels and mobile
channels.

Using AvantGo Channels
AvantGo is a free interactive service that gives you access to personalized content and
thousands of popular Web sites. Unlike mobile channels, you can subscribe to AvantGo
channels directly from your Pocket PC. Then, you synchronize your Pocket PC and
desktop computer or connect to the Internet to download the content. For more
information, visit http://avantgo.com/help.

To sign up for AvantGo

1. In ActiveSync options on the desktop computer, turn on synchronization for the
AvantGo information type.

2. In Pocket Internet Explorer on your device, tap the Favorites button.

3. Tap the AvantGo Channels link.

4. Tap the Activate button.

5. Follow the directions on the screen. You will need to synchronize your Pocket PC
with your desktop computer and then tap the My Channels button to complete the
AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list of
favorites to see a few of the most popular channels. To add or remove channels, tap the
Add or Remove link.

Using Mobile Channels
Mobile channels are sites that you subscribe to on your desktop computer. They are
stored in the Channels subfolder in the Mobile Favorites folder in Internet Explorer 4.0
or later and are downloaded to your Pocket PC during synchronization.

To use mobile channels

• Click Add Mobile Channel and check the Make available offline check box to
download the channel to your desktop computer.

The mobile channel will be transferred to your Pocket PC the next time you
synchronize.
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Refresh button

Using Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favorites and channels that have
been downloaded to your Pocket PC without connecting to the Internet. You can also
connect to the Internet through an ISP or a network connection and browse the Web.

Favorites button

Home button
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To view mobile favorites and channels

1. Tap the Favorites button to display your list of favorites.

2. Tap the mobile favorite or channel you want to view.

You will see the page that was downloaded the last time you synchronized with your
desktop computer. If the page is not on your Pocket PC, the favorite will be dimmed.
You will need to synchronize with your desktop computer again to download the page
to your Pocket PC or connect to the Internet to view the page.

Tap the mobile favorite
you want to view

Tap to add or delete a
favorite link
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To browse the Web

1. Connect to the Internet or your network in either of the following ways:

• Connect using Connections, as described in Chapter 6, “Getting Connected.”

Then switch to Pocket Internet Explorer by tapping it on the  menu.

• Connect in Pocket Internet Explorer. To select a service or type of connection,
tap Tools and then Options. Tap the Connections tab and select the connection
type. Then, whenever you want to connect to the selected service, tap Tools and
then Connect.

Note: You can have Pocket Internet Explorer automatically connect to the Internet
when you attempt to access a page that is not stored on your Pocket PC by
specifying a connection in the Connection tab in Options and selecting Access
remote content automatically.

2. Once connected, go to a specific Web page in either of these ways:

• Tap the Favorites button and then tap the favorite you want to view.

• Tap View and then Address Bar. In the address bar that appears at the top of
the screen, enter the Web address you want to visit and then tap Go. Tap the
arrow to choose from previously entered addresses.

3. To end the connection, tap Tools and then Disconnect.

Note: To add a favorite link while using the device, go to the Web page you want to
add, tap the Favorites button, tap the Add/Delete tab, tap the Add button, and enter a
name for the favorite link.
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This chapter explains how to use the companion programs on your Intermec Model 70
Pocket PC. The companion programs consist of Microsoft Pocket Word, Microsoft
Pocket Excel, Expenses, Microsoft Money, Windows Media Player, and Microsoft
Reader.

Pocket Word
Pocket Word works with Microsoft Word on your desktop computer to give you easy
access to your documents. You can create new documents on your Pocket PC, copy
documents from your desktop computer to your Pocket PC, or synchronize documents
between your desktop computer and your Pocket PC so that you have the most current
content in both locations. For more information on using ActiveSync, see the
ActiveSync online help on your desktop computer.

Pocket Word contains a list of the files stored on your Pocket PC. Tap a file in the list to
open it. To delete, make copies of, or send files, tap and hold a file in the list. Then,
select the appropriate action on the pop-up menu.

To open a new Word file

• Tap , Programs, Pocket Word, and then New. A blank document appears. Or,
if you have selected a template for new documents in the Options dialog box, that
template appears with appropriate text and formatting already provided.

You can open only one document at a time; when you open a second document, you
will be asked to save the first. You can save a document you create or edit in a variety
of formats, including Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt).

Tap a heading to change
the sort order of the list

Tap to open a document

Tap and hold an item to
see a pop-up menu of
actions
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Note: You can change the zoom magnification by tapping View and then Zoom. Then
select the percentage you want. Select a higher percentage to enter text and a lower one
to see more of your document.

If you are opening a Word document created on a desktop computer, select Wrap to
Window on the View menu so that you can see the entire document.

You can enter information in Pocket Word in one of four modes (writing, drawing,
typing, and recording), which are displayed on the View menu. Each mode has its own
toolbar, which you can show and hide by tapping the Show/Hide Toolbar button on the
command bar.

For more information on using Pocket Word, tap  and then Help.

Typing Mode
Using the input panel, enter typed text into the document. For more information on
entering typed text, see “Entering Information on the Pocket PC” in Chapter 2.

To format existing text and to edit text, first select the text. You can select text as you
do in a Word document, using your stylus instead of the mouse to drag through the text
you want to select. You can search a document to find the text you want by tapping Edit
and then Find/Replace.

Tap and hold to see a pop-
up menu of actions

Tap to change
formatting options

Tap to format text

Tap to show or hide the
toolbar
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled lines are
displayed as a guide, and the zoom magnification is greater than in typing mode to
allow you to write more easily. For more information on writing and selecting writing,
see “Entering Information on the Pocket PC” in Chapter 2.

Note: Written words are converted to graphics (metafiles) when a Pocket Word
document is converted to a Word document on your desktop computer.

Drawing Mode
To enter drawing mode, cross three ruled lines in a single stylus stroke. In drawing
mode, use your stylus to draw on the screen. Gridlines appear as a guide. When you lift
your stylus off the screen after the first stroke, you will see a drawing box indicating the
boundaries of the drawing. Every subsequent stroke within or touching the drawing box
becomes part of the drawing. For more information on drawing and selecting drawings,
see “Entering Information on the Pocket PC” in Chapter 2.

Recording Mode
In recording mode, embed a recording into your document. Recordings are saved as
.wav files. For more information on recording, see “Entering Information on the Pocket
PC” in Chapter 2.
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Pocket Excel

Pocket Excel works with Microsoft Excel on your desktop computer to give you easy
access to your workbooks. You can create new workbooks on your Pocket PC, copy
workbooks from your desktop computer to your Pocket PC, or synchronize workbooks
between your desktop computer and your Pocket PC so that you have the most current
content in both locations. For more information on using ActiveSync, see the
ActiveSync online help on your desktop computer.

Pocket Excel contains a list of the files stored on your Pocket PC. Tap a file in the list to
open it. To delete, make copies of, or send files, tap and hold a file in the list. Then
select the appropriate action from the pop-up menu.

To open a new Excel file

• Tap , Programs, Pocket Excel, and then New. A blank workbook appears. Or,
if you have selected a template for new workbooks in the Options dialog box, that
template appears with appropriate text and formatting already provided.

You can open only one workbook at a time; when you open a second workbook, you
will be asked to save the first. You can save a workbook you create or edit in a variety
of formats, including Pocket Excel (.pxl) and Excel (.xls).

Format button

Cell contents appear here
as you enter them

Tap to show or hide the
toolbar
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You can show and hide the Pocket Excel toolbar by tapping the Show/Hide Toolbar
button on the command bar.

For more information on using Pocket Excel, tap  and then Help.

Tips for Working in Pocket Excel
Note the following when working in large worksheets in Pocket Excel:

• View in full-screen mode to see as much of your worksheet as possible. Tap View
and then Full Screen. To exit full-screen mode, tap Restore.

• Show and hide window elements, such as the toolbar. Tap View and then tap the
elements you want to show or hide.

• Freeze panes on a worksheet. First select the cell where you want to freeze panes.
Tap View and then Freeze Panes. You might want to freeze the top and leftmost
panes in a worksheet to keep row and column labels visible as you scroll through a
sheet.

• Split panes to view different areas of a large worksheet. Tap View and then Split.
Then drag the split bar to where you want it. To remove the split, tap View and then
Remove Split.

• Show and hide rows and columns. To hide a hidden row or column, select a cell in
the row or column you want to hide. Then tap Format, then Row or Column, then
Hide. To show a hidden row or column, tap Tools, then Go To, and then type a
reference that is in the hidden row or column. Then tap Format, then Row or
Column, and then Unhide.

Note: If your workbook contains sensitive information, you can protect it with a
password. To do so, open the workbook, tap Edit, and then Password. Every time you
open the workbook, you will need to enter the password.
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Expenses
Expenses is a simple-to-use expenditure management program that allows you to keep
track of your expenses on the move. It is designed so that you can quickly record details
of expenses as they occur. You can also look up and amend old records, and for any
given month, view overall total expenditure with category-by-category breakdowns. It
even allows you to input a period of time, and print out chronologically details of all
records within that period.

To open Expenses

• Tap , Programs, and then Expenses. You can create new records and edit and
delete existing records.

Note: You can create as many records as you want, up to the amount of storage
capacity. The speed of the Pocket PC will be affected if you store too much information
on your Pocket PC.

For more information on using Pocket Excel, tap  and then Help.

Creating Records
When you open Expenses a blank record automatically appears with the day’s date and
record number.

To create a record

1. If the record is not for today, press the down arrow next to the date. In the pop-up
calendar that appears select a month by pressing the left and right arrows and then a
day by tapping the calendar.

Tap to reveal the calendar

Tap to select the month

Tap to select the day
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2. Confirm the date by tapping outside the calendar. The number of this new record is

automatically displayed so continue to the next item.

3. Tap Company or Personal, as appropriate.

4. Next to Category, tap the arrow and select a description from the drop-down menu.

5. Below enter the cost of the expense – if you tap in the box the keyboard will pop-
up.

6. In Details enter any additional information about the record that you think is
necessary.

7. To add the record to memory, press New.

Tap to display the drop-
down menu

Select a type of expense
from the list
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Calculating and Viewing Expenditure Totals
To view the overall total expenditure for a given period, tap the  icon in the toolbar
at the bottom of the screen and enter a period of time. The statistics displayed are
broken down by Category—with an overall total also given.

For statistics covering another period tap the arrow next to the date at the top of the
screen, and then in the pop-up calendar that appears select a month by pressing the left
and right arrows and a day by tapping a number from the body of the calendar. To
confirm the date, tap outside the calendar.

Tap to select a date

View expenses broken
down by category

View total expenses
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Expense Screen

Printing a List of Records

1. Press the printer  icon in the toolbar at the bottom of the screen.

2. At the top of the screen tap Starting Date and Ending Date to select the period
within which you want a printout of records. For this, you can select a period up to
12 months within any year.

Tap to display the
calendar

Select a day in the month
by tapping a number
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3. The records will be listed, starting with the earliest first.

Note: The records are stored in a database on your Pocket PC. To print, view or
manipulate these records, they must be first converted to a text file and copied to a
folder on your PC.

4. Tap Save to change the file to a text file. You will be asked if you want the file to
be called DAILYACCOUNT.TXT, tap OK.

5. To copy to your PC open Windows Explorer on your desktop computer, double
click on Mobile Devices, and then My Pocket PC.

6. Select the DAILYACCOUNT.TXT file, copy and paste into My Documents on
your desktop computer.

7. In Notepad click File, and then Open from the drop-down menu. In the screen that
appears select text files from the Types of File box, double click on
DAILYACCOUNT.TXT and follow the instructions that appear.

Tap to save as a text file

Tap to select the date

View a list of records for
the above specified period
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Microsoft Money

Use Microsoft Money to easily enter and view your financial transactions, check your
account balances, and track your investments. If you are using Microsoft Money on
your desktop computer, you should synchronize it with your Pocket PC first so that you
will not have to enter your accounts and other required information manually on your
Pocket PC.

The first time you synchronize, all Microsoft Money information on the Pocket PC will
be replaced with information from your desktop computer. If you do not use Microsoft
Money on your desktop computer, Microsoft Money on the Pocket PC can still be used
to help organize your finances, but you will not be able to synchronize the financial
information with your desktop computer.

Note: Before you synchronize, you must run the Setup program found in the MSMoney
folder under Extras on the ActiveSync CD (Part No. 871-013-201)

For more information on using Microsoft Money, tap  and then Help.

Creating Accounts

1. Tap , Programs, Microsoft Money, and then New. A screen for entering
account details with a Required and an Optional tab appears.

2. Enter the name and type of the account on the Required tab.

3. Tap the Optional tab and then tap ok. The name of the account appears in the
Account Manager with its opening balance. The total of all balances for your
accounts appears at the bottom of the screen.

Microsoft Money shows that you are in the Account Manager in the upper-left corner of
the screen. Tap the name Account Manager. A list of the five screens within Microsoft
Money appears. Tap the screen you want to see.



Model 70 Pocket PC User’s Guide

5-14

Microsoft Money—Account Manager Screen

Viewing the Account Register
The Account Register displays all transactions for that account that are stored on your
Pocket PC. For each transaction, you will see the date, the payee, the amount, and the
running balance of your account as a result of the transaction. The ending account
balance is displayed at the bottom of the screen.

To view the account register

• In the Account Manager, tap the account name.

Tap to see the Account
Register

Tap and hold to see a pop-
up menu of actions

Balance for all accounts



Companion Programs

5-15

5
Microsoft Money—Account Register Screen

Note: To switch between accounts, tap the name of the current account in the upper-
right corner and select another account from the list.

Entering Transactions

1. In the Account Register, tap New to create a new transaction.

2. On the Required tab, Microsoft Money automatically creates a withdrawal and
enters today’s date. If you are not entering a withdrawal, tap the Type box and
select Deposit or Transfer. You can also change the account in which the
transaction is being created.

3. Tap the Payee box. Using the input panel, enter the payee for your transaction. As
you type, Microsoft Money tries to guess the payee that you are entering from your
list of existing payees. If Microsoft Money guesses correctly, tap another field or
tap Tab to accept the payee.

4. When you accept a payee, Microsoft Money enters the same amount, category, and
subcategory that you used for the last transaction with that same payee. This
information gets entered on the Required tab and the Optional tab.

5. Tap ok to save the new transaction.

Transaction amount

Tap to view details

Tap and hold to see a pop-
up menu of actions

Ending balance for
account

Running balance for
account
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Microsoft Money—Entering Transactions

Note: If you do not want Microsoft Money to automatically enter information, tap
Tools and then Options and turn off AutoComplete+.

Entering and Tracking Investments
In the Investments screen, you can track the value of the investments in your portfolio.
The Investments screen displays each investment with the current number of shares,
their price, and market value. The total market value for all of your investments is
displayed at the bottom of the screen.

To create a new investment

1. In the Investments, tap New.

2. Enter the name, symbol, current price, and number of shares.

3. Tap ok to save the new investment.

Tap ok to return to the
Account Register

Tap to select the
transaction type

Tap to select another
account

Tap to enter the payee

Tap to enter the date

Tap to enter the amount
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Microsoft Money can update investment prices from the MoneyCentral Web site. To do
this, open a connection to the Internet and tap Update Investments on the Tools menu.
When the update is complete, Microsoft Money will record the date and time and
display it after Last Quote Update at the bottom of the screen. If you do not have an
Internet connection from your Pocket PC, you can manually update the investment
prices by tapping the investment and entering a new price with the input panel.

Note: Microsoft Money can get a quote update over any direct (IP) Internet connection,
including a wireless connection or network connection. If you cannot get a quote
update, check with your Internet service provider (ISP) or network administrator to see
if you require a proxy server to connect to the Internet. If so, tap Tools and then
Options and set up the proxy server.
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Windows Media Player for Pocket PC
Use Windows Media Player for Pocket PC to listen to digital audio files. For more

information on using Windows Media Player, tap  and then Help.

To open the Windows Media Player

• Tap , and then Windows Media.

Indicates progress of the
current track

Track information

Skip forward

Play/Pause

Stop

Volume

Skip back

Shuffle playlist
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Using Windows Media Manager for the Pocket PC
Use Windows Media Manager for the Pocket PC on the desktop computer to create
digital audio files in Windows Media format and to transfer audio content to your
Pocket PC or storage card. With Windows Media format, you can create high-quality
audio for your Pocket PC without using large amounts of Pocket PC memory.

You can transfer the following media formats to your Pocket PC for use with the
Windows Media Player: ASF (Advanced Streaming Format), WMA (Windows Media
Audio), MP3 (MPEG Audio Layer 3), and WAV (waveform).

Note: Windows Media Manager is included in the Extras folder on the ActiveSync CD
(Part No. 871-013-201). You must install Windows Media Manager on your desktop
computer to copy and convert digital audio files
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What is Packaged Content?
Packaged content is digital music that has been encrypted for distribution to prevent
unauthorized access to copyrighted content. Windows Media Player for Pocket PC
cannot play packaged content without a valid license. First use Windows Media Player
on the desktop computer to obtain packaged content that has a license that allows
transferring the content to your Pocket PC. Then use Windows Media Manager for
Pocket PC to transfer the packaged content and its license to your Pocket PC or storage
card. To successfully transfer packaged content, your Pocket PC or storage card may
require a hardware serial number.

You can play packaged content until the license expires. During license download, you
will be informed of the terms of the license. License terms can be for an unlimited time,
a set amount of time, or a set number of playbacks. A license can support content being
copied to a Pocket PC or storage card an unlimited number of times or one time only.
Terms are entirely dependent on the content provider.

Using the Playlist Manager
Use the Playlist Manager to set the track playback order. All My Music is the default
playlist. It contains all digital audio files available for playback on your Pocket PC and
storage card. To see a list of recently selected playlists, tap Select Playlist. To create or
edit playlists, tap All Playlists.

Tap and hold a track or playlist to perform actions such as copying, moving, and
deleting.
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Microsoft Reader

Use Microsoft Reader to read electronic books on your Pocket PC. Download books to
your desktop computer from your favorite eBook Web site. Then, use ActiveSync to
copy the book files to your Pocket PC. The books appear in the Reader Library, where
you can tap them in the list to open them.

The Reader Guidebook contains all the information you will need to use the software.
To open the Guidebook, tap Guidebook on the Reader command bar. Or, on a book
page, tap the book title and then tap Guidebook on the pop-up menu.

To open Microsoft Reader

• Tap , Programs, and then Microsoft Reader.

Getting Books on Your Device
You can download book files from the Web. Just visit your favorite eBook retailer and
follow the instructions to download the book files. Use ActiveSync to download the
files from your desktop computer to your Pocket PC as described in the Read Me file in
the MSReader folder.

Using the Library
The Library is your home page; it displays a list of all books stored on your Pocket PC
or storage card.

You can go to the Library by tapping Library on the Reader command bar. Or on a
book page, tap the book title and then tap Library on the pop-up menu.
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To open a book

• Tap the book title in the Library list.

Reading a Book
Each book consists of a cover page, an optional table of contents, and the pages of the
book. Navigation options are listed in the bottom portion of the cover page. Page
through the book by using the Up/Down control on your Pocket PC or by tapping the
page number on each page.

The first time you open a book, you will probably want to go to the first page or to the
table of contents, if there is one. Subsequently, whenever you open the book, you will
be automatically taken to the last page read.

In addition to the text, each book page includes a page number and book title. You can
annotate the book with highlighting, bookmarks, notes, and drawings. You can also
search for text and look up definitions for words.

Tap to select a
sort order

Tap to scroll through the
library list

Tap to open a book
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5
Microsoft Reader Screen

Using Reader Features
Reading a book electronically gives you several options not available with paper books.
These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on the pop-up
menu, as described here:

• Search for Text. Find text in a book by tapping Find on the pop-up menu. Change
the text that appears in the Find box, if necessary, and tap the desired Find option.
The Reader finds the text and highlights it on the page. Tap outside the Find box to
close it. To return to your original page, tap the title and then tap Return on the
pop-up menu.

• Copy Text. You can copy text from a book into any program that accepts text. On a
book page, select the text you want to copy. Then, tap Copy Text on the pop-up
menu. The text you have copied can be pasted into the program of your choice.

• Bookmarks. When you add a bookmark to a book, a color-coded bookmark icon
appears in the right margin. You can add multiple bookmarks to a book. Then, from
anywhere in the book, you can tap the bookmark icon to go to the bookmarked
page.
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• Highlights. When you highlight text, it appears with a colored background, just as
if you used a marker pen.

• Notes. When you attach a note to text, you enter the text in a note pad that appears
on top of the book page. A note icon appears in the left margin. You can show or
hide the note by tapping the icon.

• Drawings. When you add a drawing, a drawing icon appears in the bottom-left
corner of the page, and drawing tools appear across the bottom of the page. Draw by
dragging your stylus.

Note: To see a list of a book’s annotations, including bookmarks, highlights, text notes,
and drawings, tap Annotations Index on the book’s cover page. You can tap an entry in
the list to go to the annotated page.
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This chapter explains how you can use your Intermec Model 70 Pocket PC to exchange
information with other Windows-powered devices as well as your desktop computer, a
network, or the Internet.

Connecting the Pocket PC
There are many different ways you can connect the Pocket PC to your desktop
computer, network, or the Internet. You can

• Directly connect to a desktop computer using a cradle or an auto-sync cable. For
help, see the ActiveSync online help on your desktop computer.

• Connect to your desktop computer to synchronize remotely. For help, see the
ActiveSync online help on your desktop computer or the Connections online help
on the Pocket PC.

• Connect to another infrared-equipped device. For help, see “Transferring Data
Using Infrared” later in this chapter.

• Connect to your Internet service provider (ISP) using a modem card. The
communication software for creating an ISP connection is already installed on your
Pocket PC. Your service provider will provide software needed to install other
services, such as paging and fax services. For help, see “Connecting to an ISP
Through a Modem” later in this chapter.

• Connect to the network at your company or organization using an Ethernet card. For
help, see “Connecting to a Network” later in this chapter.

Precautions for Products with Modems, Telecommunications, or Local Area Network
Options
Be sure to observe the following precautions when operating telecommunications and
network equipment. Failure to observe these precautions could result in fire, bodily
injury, and damage to the equipment.

• Do not connect or use a modem or telephone (other than a cordless type) during a
lightning storm. There may be a remote risk of electric shock from lightning.

• Never connect or use a modem or telephone in a wet location.

• Do not plug a modem or telephone cable into the Network Interface Card (NIC)
receptacle.

• Disconnect the modem cable before opening a product enclosure, touching or
installing internal components, or touching an uninsulated modem cable or jack.

• Do not use a telephone line to report a gas leak while you are in the vicinity of the
leak.
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Transferring Data Using Infrared
Using infrared (IR), you can send and receive information, such as contacts and
appointments and files, between two Windows-powered devices. You can also connect
to the Internet through an infrared modem.

To send information

1. Switch to the program where you created the item you want to send and locate the
item in the list. If you want to send more than one item, drag the stylus across the
items you want to send.

2. Align the IR ports so that they are unobstructed and within a close range.

3. Tap and hold the item, and tap Send via Infrared on the pop-up menu.

To receive information

1. Align the IR ports so that they are unobstructed and within a close range.

2. Tap , Programs, and then Infrared Receive.

Note: You can also receive items from Tasks, Contacts, Calendar, and Notes by tapping
Tools and then Receive via Infrared in list view.
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Connecting to an ISP Through a Modem

You can connect to your ISP by creating a modem connection. Once connected, you can
send and receive e-mail messages and view Web pages. You can also use the program
Easy Online.

To connect to an ISP through a modem

1. Obtain the following information from your ISP: ISP dial-up access telephone
number, user name, password, and TCP/IP settings. Some ISPs require information
in front of the user name, such as MSN/username.

2. Insert a Compact Flash modem card or a PCMCIA modem card into the Pocket PC
expansion slot and connect it to a telephone line.

3. Tap  and then Settings. On the Connections tab, tap Modem.

4. Tap New connection.
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5. Enter a name for the connection, such as “ISP Connection.”

6. In the Select a modem list, select your modem type. If you are using an infrared
modem, select Generic IRDA modem. If you are using an external modem that is
connected to your Pocket PC with a cable, select Hayes Compatible on COM1.

7. You should not need to change any settings in Advanced. Most ISPs now use a
server-assigned address. If the ISP you are connecting to does not use a server-
assigned address, tap Advanced and then the TCP/IP tab and enter the address.
When finished, tap ok and then Next.

8. Enter the access phone number and tap Next.

9. Select other desired options and tap Finish.

10. On the Dialing tab, specify your current location and phone type (most phone lines
are tone). These settings will apply to all connections you create.

Once you have created the connection, it appears in , Programs, Connections. To
start the connection, remove your Pocket PC from the cradle, tap the connection icon,
enter your user name and password, and tap Connect. Once connected, you can:

• Send and receive e-mail messages using Inbox. Before you can use Inbox, you need
to provide the information it needs to communicate with the e-mail server. For
specific instructions, see “Connecting Directly to an E-mail Server,” later in this
chapter.

• Visit Web pages using Pocket Internet Explorer. For more information, see Chapter
4, “Microsoft Pocket Internet Explorer.”

Note: You can quickly return to Modem Settings to change connection settings by
tapping the Modem link at the bottom of the Connections folder. To return to the
Connections folder, tap the Connections link.
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Connecting to a Network

If you have access to a network, you can send e-mail messages, view Intranet pages,
synchronize your Pocket PC with your desktop computer, and possibly access the
Internet. You can connect to your network in one of two ways:

• Create a modem connection by using a RAS account. Before you can create this
modem connection, your network administrator will need to set up a RAS account
for you. For help, see “Creating a Modem Connection” in the next section.

• Use an Ethernet card and a net tap to connect to the network. You must purchase
and configure an Ethernet card that is compatible with your Pocket PC. For help,
see “Creating an Ethernet Connection.”

Creating a Modem Connection

1. Get the following information from your network administrator: dial-up access
telephone number, user name, password, domain name, and TCP/IP settings.

2. Insert a Compact Flash modem card or a PCMCIA modem card into the Pocket PC
expansion slot and connect it to a telephone line.

3. Tap  and then Settings. On the Connections tab, tap Modem.

4. Tap New connection.

5. Enter a name for the connection, such as “Company Connection.”

6. In the Select a modem list, select your modem type. If your modem type does not
appear, try reinserting the modem card. If you are using an external modem that is
connected to your Pocket PC with a cable, select Hayes Compatible on COM1.

7. You should not need to change any settings in Advanced. Most servers now use a
server-assigned address. If the server you are connecting to does not use a server-
assigned address, tap Advanced and then the TCP/IP tab and enter the address.
When finished, tap ok and then Next.

8. Enter the access phone number, and tap Next.

9. Select other desired options, and tap Finish.

10. On the Dialing tab, specify your current location and phone type (most phone lines
are tone). These settings will apply to all connections you create.
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Creating an Ethernet Connection

1. Get the following information from your network administrator: user name,
password, and domain name.

2. Insert the Ethernet card into your Pocket PC. For instructions on inserting and using
the Ethernet card, see the owner’s manual for the card.

3. The first time you insert the card, Network Settings will appear automatically so
that you can configure the Ethernet card. Most networks use DHCP, so you should
not have to change these settings unless your network administrator instructs you to

do so. Tap ok. (If it does not appear or to change settings later, tap  and then
Settings. On the Connections tab, tap Network and then the adapter you want to
change.)

4. Connect the Ethernet card to the network by using a network cable. For information,
see your owner’s manual.

5. To synchronize your Pocket PC with your desktop computer, tap , and then
Programs. Tap the Connections folder, and then ActiveSync. Select Network
Connection as the connection method and then tap Connect. Remote
synchronization with a desktop computer will work only if you have set up a
partnership with that computer through ActiveSync and have set ActiveSync to
allow remote connections. Other restrictions apply. For help, see the ActiveSync
online help on the desktop computer.

6. To access your e-mail server or the intranet, tap  and then Settings. On the
Connections tab, tap Network and then the Identification tab. Enter your user
information. If you need assistance, see your network administrator.

Once you have created the connection, it appears in , Programs, Connections. To
start the connection, remove your Pocket PC from the cradle, tap the connection icon,
enter your user name, domain, and password, and tap Connect. Once connected, you
can:

• Send and receive e-mail messages by using Inbox. Before you can use Inbox, you
need to provide the information it needs to communicate with the e-mail server. For
specific instructions, see “Connect Directly to an E-mail Server,” later in this
chapter.

• Visit Internet or intranet Web pages by using Pocket Internet Explorer. You may
need to set up a proxy server to visit Internet Web pages. For more information on
setting up a proxy server, see the Pocket Internet Explorer online help on the Pocket
PC.

• Synchronize with your desktop computer. For more information, see the
ActiveSync online help on the desktop computer.
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Connecting Directly to an E-mail Server

You can set up a connection to an e-mail server so that you can send and receive e-mail
messages by using a modem or network connection and Inbox on your Pocket PC.

Note: The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP
gateway.

Inbox does not currently support connecting with proprietary e-mail protocols, such as
AOL and MSN™. However, you can still access the Internet through these services.
There may be third-party programs available that would enable you to send and receive
e-mail messages through proprietary protocols.

You can use multiple e-mail services to receive your messages. For each e-mail service
you intend to use, first set up and name the e-mail service. If you use the same service to
connect to different mailboxes, set up and name each mailbox connection.

To set up a e-mail service

1. In Inbox on your Pocket PC, tap Services, and then New Service.

2. Select POP3 or IMAP4 as the service type, name the service, and tap Next. For
information on which service type to select, ask your ISP or network administrator.

3. If you have created a connection you want to use, select it from the Connection list.
If you have not, select Create new connection and follow the steps in the wizard.
When you return to this screen at the end of the wizard, select the connection you
created from the Connection list.

A wizard will walk you through the remaining steps. For an explanation of a screen, tap
Start and then Help. When finished, tap Services and then Connect to connect to your
e-mail server. For more information on using the Inbox program, see “Using Inbox” in
Chapter 3.

Ending a Connection
If you started the connection from a program, such as Inbox or Pocket Internet Explorer,

disconnect from that program first. Then, tap  and then Today. Tap  or  at the
bottom of the screen and then Disconnect.

To end a network connection, remove the card from your Pocket PC.
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Get Help on Connecting
More information on the procedures described here, as well as information on additional
procedures, can be found in the following locations:

• “Using Inbox” in Chapter 3.

• Chapter 7, “Troubleshooting.”

• Online help on the Pocket PC. Tap  and then Help. Tap View, All Installed
Help, and then Inbox or Connections.

• ActiveSync online help on the desktop computer. In ActiveSync, click Microsoft
ActiveSync Help on the Help menu.
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This chapter helps you troubleshoot problems you may experience with the Intermec
Model 70 Pocket PC.

Resetting the Pocket PC
You can perform a soft reset or a full reset. If your Pocket PC responds slowly, stops
responding as expected, or “freezes,” try soft resetting it. If you want to clear all data
from your Pocket PC and return it to the factory defaults or if you forget your Pocket
PC password, you need to perform a full reset and clear the memory.

Performing a Soft Reset
A soft reset causes the Pocket PC to restart and re-adjust memory allocation. Unsaved
data in open windows may be lost.

To perform a soft reset

• Use the stylus to press and hold the Reset button for about two seconds.

Clearing Memory (Resetting to Factory Defaults)

Caution
Clearing memory deletes all data and restores the Pocket PC to its default settings.
Programs installed at the factory remain, while data you have created and programs
you have installed are erased.

Conseil
L’effacement de la mémoire supprime toutes les données et rétablit les paramètres par
défaut du Pocket PC. Les programmes installés en usine sont conservés. Cependant,
les données que vous avez créées et les programmes que vous avez installés sont
effacés.

Note: Make sure you back up your Pocket PC data so that if you need to clear memory,
you can restore the data on your Pocket PC. For more information, see “Backing Up and
Restoring Data” in Chapter 2.
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To clear memory

1. Turn on the Pocket PC.

2. Press and hold the Power button, and use the stylus to press and hold the Reset
button for about two seconds.

3. If a message appears on the screen, confirm that you want to clear memory.

Or,

Remove the main battery pack and the backup battery, wait 5 minutes, and then
reinsert them.

Tips for Extending Battery Charge
When batteries are low, you will see a battery icon in the status bar of the Today screen.
Replace or recharge low batteries as soon as possible. When main batteries are
discharged, your data will be preserved by the backup battery. If the backup battery is
discharged, you run the risk of losing the data on your Pocket PC.

You want your Pocket PC battery charge to last as long as possible, especially when you
are on the road. Under normal conditions, you can get many hours of use from a single
set of batteries or from a full charge. Here are a few tips to help you get the most from
them.

Use External Power Whenever Possible
Use the AC adapter to plug your Pocket PC into external power whenever possible,
especially when:

• Establishing a remote connection (some modems use a lot of power).

• Using the backlight feature of your Pocket PC display.

• Connecting to a desktop computer.

• Letting the notification light flash for extended periods.

Shorten Auto-Suspend Time
While on battery power, your Pocket PC automatically suspends operation if you have
not touched the hardware buttons or used the stylus for a specified period. Maximize

battery life by shortening the time. Tap  and then Settings. On the System tab, tap
Power, and then adjust the On battery power setting.
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Turn Off Sounds You Don’t Need
The Pocket PC produces sounds in response to a number of events, such as warnings,
appointments, and screen taps or hardware-button presses. To optimize battery life, turn

off any sounds you don’t need. Tap  and then Settings. On the Personal tab, tap
Sounds & Reminders and clear check boxes on the Volume and Reminders tabs.

Turn Off Notification Light
Tap  and then Settings. On the Personal tab, tap Sounds & Reminders. On the
Reminders tab, clear the Flash light for check box.

Managing Memory
Memory on the Pocket PC is shared between storage memory and program memory.
Storage memory is used to store the information you create and programs you install.
Program memory is used to run programs on the Pocket PC. The Pocket PC
automatically manages the allocation between storage and program memory. However,
in some situations, such as when memory is low, the Pocket PC may not be able to
automatically adjust the allocation.

If you receive a message stating that storage or program memory is unavailable, you can
try adjusting the storage memory or the program memory.

Adjusting Storage Memory
• Move data to a storage card.

• Tap , Programs, and then File Explorer. Tap and hold the file you want to
move, and tap Cut. Browse to the My Documents folder in the storage card folder,
tap Edit, and then tap Paste. Files stored in folders other than My Documents or
stored in subfolders within subfolders in My Documents may not show up in the list
view of some programs. When using Notes, Pocket Word, or Pocket Excel, you can
also move files by opening the item and tapping Tools or Edit and then
Rename/Move.

• Move e-mail attachments. In Inbox, tap Tools and then Options. On the Storage
tab, select Store attachments on storage card. All attachments are moved to the
storage card, and new attachments are automatically stored on the storage card.

• Set programs such as Notes, Pocket Word, and Pocket Excel to automatically save
new items on the storage card. In the program, tap Tools and then Options.
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• If you are copying files from your desktop computer or another device to your

Pocket PC, try adjusting the slider in the Memory setting. Tap  and then
Settings. On the System tab, tap Memory and check whether the slider can be
adjusted manually before copying files.

• Delete unnecessary files. Tap , Programs, and then File Explorer.  Tap and
hold the file, and then tap Delete on the pop-up menu. To find your largest files, tap

 and then Find. In the Type list, tap Larger than 64 KB, and then tap Go.

• In Internet Explorer options, delete all files and clear history. In Internet Explorer,
tap Tools and then Options. Tap Delete Files and Clear History.

• Remove programs you no longer use. Tap  and then Settings. On the System
tab, tap Remove Programs. Tap the program you want to remove and then
Remove.

• Clear program memory as described in the following section. This will free some
program memory so that it can be allocated to storage memory.

Adjusting Program Memory
• Stop programs you are not currently using. In most cases, programs automatically

stop to free needed memory. However, in some situations, such as when
confirmation dialog boxes are waiting for a user response, the program may not be

able to automatically stop. To check the state of your active programs, tap  and
then Settings. On the System tab, tap Memory and then the Running Programs
tab. Tap the program you want to view and then tap Activate. Close any open
windows or messages and return the program to list view. If this does not work, you
can stop the program manually. First, make sure that your work is saved by closing
open items and returning the program to list view. Then, stop the program by
tapping Stop or Stop All on the Running Programs tab.

• Clear storage memory as described in the preceding section. This will free some
storage memory so that it can be allocated to program memory.

• Reset your Pocket PC, as described in “Resetting the Pocket PC” earlier in this
chapter.
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Fixing Screen Problems

If your screen freezes or responds slowly, reset your Pocket PC. See “Resetting the
Pocket PC” earlier in this chapter. If your screen is blank, dark, or otherwise hard to
read, try these solutions.

Screen Is Blank
If your Pocket PC does not respond when you briefly press the Power button, press and
hold the button for a full second. If that does not work:

• Make sure your battery cover is locked and all expansion slots are secured.

• Plug the device into AC power.

• Change or recharge the main battery pack and backup battery.

• Adjust the display contrast. On some Pocket PCs, the screen can darken or lighten
to the point that it appears to be powered off.

• Reset the device. See “Resetting the Pocket PC” earlier in this chapter.

Screen Is Dark
Prolonged exposure to direct sunlight may cause your Pocket PC screen to temporarily
darken. This is normal for LCD screens and is not permanent.

Screen Is Hard to Read
Pocket PC screens without backlighting can be hard to read under reduced light.
Position a lamp so that the light shines directly on the screen.

If you are having a hard time viewing a document in Notes, try changing the size of the
view. To do this, tap a zoom percentage on the Tools menu. In Pocket Word and Pocket
Excel, on the View menu, tap Zoom and then select a zoom percentage. In Pocket
Internet Explorer, on the View menu, tap Text Size and then select a size.

If you are having a hard time viewing Pocket Outlook data, try enlarging the display
font. To do this within Calendar, Tasks, or Contacts, tap Tools, then Options, and then
select Use large font.
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Stylus Problems
If you are experiencing inaccurate responses to stylus taps, adjust the touch screen to
respond more accurately to screen taps.

To adjust the touch screen

1. Tap  and then Settings.

2. On the System tab, tap Align Screen.

Fixing Connection Problems
If you are having trouble connecting to your desktop computer, infrared-equipped
device, ISP, or network, follow these procedures.

Cable and Cradle Connection Problems
If you encounter problems when connecting to your desktop computer using the auto-
sync cable or cradle, try these procedures. Additional troubleshooting information is
available in the Connections online help on the Pocket PC and in the ActiveSync online
help on the desktop computer.

• Ensure the Pocket PC is turned on.

• If a modem or Ethernet card is inserted into your Pocket PC, remove it.

• Ensure that you do not have any other active connections. Tap  and then Today.

Tap  or  at the bottom of the screen and then Disconnect.

• Ensure the cable is securely plugged into the COM port on the back of your desktop
computer. Use the cable that came with the Pocket PC without any extra cables or
extenders attached.

• Plug the other end of the cable securely into the correct port on your Pocket PC. If
you are using a cradle, push your Pocket PC securely into the cradle.

Infrared (IR) Connection Problems
If you are unable to use IR to transfer information, try the following:

• Transfer only one file or no more than 25 contact cards at a time.

• Line up the IR ports so that they are unobstructed and within a close range.

• Make sure nothing is between the two IR ports.

• Adjust the room lighting. Some types of light interfere with IR connections. Try
moving to a different location or turning off some lights.
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Modem Connection Problems
You may encounter the following problems when using a modem. Additional
troubleshooting information is available in the Connections online help on the Pocket
PC and in the ActiveSync online help on the desktop computer.

Can’t Dial Out

• Remove your Pocket PC from the cradle. You cannot connect using a modem if
your Pocket PC has an active connection with the desktop computer.

• Verify that the modem is firmly seated and connected to your Pocket PC and the
telephone jack.

• Make sure the telephone line is analog. (Analog telephone lines transmit data in
analog instead of digital form. Your home telephone line is most likely analog,
while office telephone lines are often digital.)

• If you create a modem connection for an external modem, select Hayes
Compatible on COM1 as your modem. If you are using a modem card, select the
modem card as your modem.

• To use an external modem, you need to use a NULL modem cable and appropriate
adapters to connect the external modem to your Pocket PC.

• Make sure the modem is waiting for a dial tone. Tap  and then Settings. On the
Connections tab, tap Modem. Tap your connection and tap Next twice. Make sure
Wait for dial tone before dialing is selected.

• For international calls, allow more time for the call to go through. Tap  and then
Settings. On the Connections tab, tap Modem. Tap your connection and tap Next
twice. Clear Cancel the call if not connected within or increase the number of
seconds allowed. For information on dialing patterns, see Connections Help on the
Pocket PC.

Can Dial Out but Cannot Make a Proper Connection

• Make sure the network to which you are trying to connect supports the Point-to-
Point Protocol (PPP). Your Internet service provider or network administrator can
verify this.

• Verify that the location is correct. Tap  and then Settings. On the Connections
tab, tap Modem. On the Dialing tab, make sure that Location reflects your current
location. Tap Dialing Patterns to make sure the correct sequence of numbers is
being dialed. For information on dialing patterns, see Connections Help on the
Pocket PC.



Model 70 Pocket PC User’s Guide

7-10

• Verify that you are using the right phone number for the modem you are trying to

reach Tap  and then Settings. On the Connections tab, tap Modem. Tap the
connection and then Next and double-check the phone number you are trying to
reach.

Connection Is Unreliable

• Make sure the modem is firmly seated and connected to your Pocket PC and the
telephone jack.

• Disable call waiting. Tap  and then Settings. On the Connections tab, tap
Modem. On the Dialing tab, select Disable call waiting. Then enter the disable
code specified by your telephone company.

Network Connection Problems
The following solutions may help if you encounter problems when using a network card
for network connections. Additional troubleshooting information is available in the
Connections online help on the Pocket PC and in the ActiveSync online help on the
desktop computer.

• Verify that you have an Ethernet card that is compatible with your Pocket PC.

• Verify that you have added necessary server information. Tap  and then
Settings. On the Connections tab, tap Network. Tap your installed adapter (usually
your Ethernet card’s name) and enter any necessary information. Most networks use
DHCP, so you should not have to change these settings unless your network
administrator instructs you to do so.

• If Network Connection is not listed as a connection method in the ActiveSync
dialog box when starting synchronization, wait a few minutes and try again. Also, if
synchronization does not start right away, the network is probably busy, and it may
take a minute for your Pocket PC to connect to the network.

• Make sure that the proper drivers for your card are installed on the Pocket PC. For
more information, see the owner’s manual for the network card.

• Verify with your network administrator that your user name and password are
correct.

• Verify with your network administrator that the network you are trying to connect
to is available, or try to connect to it from another computer.

• You may need to change the device name if you are trying to connect to a network
and cannot because another Pocket PC with the same name is already connected. To

change the Pocket PC name, tap  and then Settings. On the System tab, tap
About, and then the Device ID tab.
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This appendix provides the specifications for the Intermec Model 70 Pocket PC,
explains how to use Character Recognizer, and explains how to transfer data from a
palm-sized PC.

Specifications

Feature Model 70 Pocket PC

Processor

Memory

Intel SA-1110 CPU

SDRAM: 16 MB; Flash ROM: 16 MB; ROM 16MB

LCD module 3.8� ���[��� JUDSKLF LQ ���� PP SLWFK 49*$� %�: �� JUD\ 671

Semi-Transmission

Buttons Four programmable buttons; power button; jog wheel for scroll up,
down, action; record and Your Desktop button; reset button.

Stylus 95 mm, maximum diameter 5 mm

Notification One PDA LED for event alarm and battery charge.

Audio Built-in microphone, speaker and buzzer; one earphone/mike jack with
stereo sound; MP3 stereo

Interface Compact Flash slot Type 1; feature connector (serial, cradle, USB
slave); infrared (IrDA) SIR x1; DC jack; RF connector.

Power Up to 15 hours battery life; rechargeable 3.8 prismatic type battery;
backup cell coin battery: CR2032; AC adapter (input 100-240 VAC,
0.3A, Output 5VDC/2A); built-in charger.

Accessories AC adapter; RS-232 auto-sync cable; earplug; service kit; protective
carry case; cradle: DC jack, serial port, USB slave.

Docking cradle Dimension: 100 mm (W) x 37.9 mm (H) x 110 mm (Thickness); table
sitting format; non foldable; DC jack; serial cradle as default; one LED.
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Using Character Recognizer
Using Character Recognizer, you can write alphanumeric characters directly on your
Pocket PC screen with your stylus, just as you would on a piece of paper. The characters
you write are translated into typed text. Use Character Recognizer anywhere you want
to enter text, for example, to write a note or to fill in fields in a dialog box.

The Character Recognizer input panel is divided into three writing areas. Letters written
in the left area (labeled ABC) create uppercase letters and letters written in the middle
area (labeled abc) create lowercase letters. The right area (labeled 123) is for writing
numbers, symbols, special characters, and punctuation.

The Character Recognizer input panel is also divided into two writing areas. When you
write in either of these areas, interpretations of the character you are writing will appear
in the top-left box. The two boxes allow you to write another character while you are
waiting for Character Recognizer to interpret the first.

The letters you write are
converted to typed text on
the screen

Write capitals
here

Write numbers here
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The following chart is a partial display of the characters you can write while in
lowercase mode (the dot on each character is the starting point for writing). For more

information on using Character Recognizer and for demos of all characters, tap on
the Character Recognizer input panel.
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How to Transfer Palm-Size PC Data to a Pocket PC
1. Install Microsoft ActiveSync 3.1 on your desktop computer.

2. Synchronize your palm-size PC with your desktop computer so that the information
on your desktop computer is current.

3. If you have files on your palm-size PC that you want to transfer, such as Note Taker
notes and recordings, turn file conversion off in ActiveSync options so that the files
stay in device format, and use the ActiveSync Explorer to copy the files to your
desktop computer. For specific instructions, see the ActiveSync online help on the
desktop computer.

4. Synchronize your Pocket PC with your desktop computer. This will update your
Pocket PC using the current data on your desktop computer (Step 2).

5. Reinstall programs. Check whether new versions that have been optimized for the
Pocket PC are available.

6. Using the ActiveSync Explorer, copy the files you transferred to your desktop
computer in step 3 to your Pocket PC.

7. In ActiveSync, turn file conversion on again.

8. Enter your settings and connection information on the Pocket PC.

To transfer offline folders in Inbox on your palm-size PC to your Pocket PC

1. Connect your palm-size PC to your desktop computer and then click Windows CE
Inbox Transfer on the Microsoft Outlook Tools menu.

2. Select Copy or move selected messages to your desktop computer and then click
the Browse button.

3. Select the offline folder that contains the messages you want to transfer to your
desktop computer and then click OK.

4. Click the Transfer button and select the folder you want to transfer the messages to
or click New Folder to create a new folder. Click OK to transfer the messages.
Now you must transfer the messages from your desktop computer to your Pocket
PC.

5. In Inbox on your Pocket PC, tap Tools and then New Folder and create a folder for
the messages you are going to transfer.

6. In Outlook on your desktop computer, select the messages you want to transfer.

7. Connect your Pocket PC to your desktop computer and then click Windows CE
Inbox Transfer on the Outlook Tools menu.
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8. Select Copy selected messages to your Pocket PC and then click the Browse

button.

9. Select the offline folder on your Pocket PC you want to transfer the messages to and
then click OK.

10. Click the Transfer button. The selected messages are moved to your Pocket PC.
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